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	R2R History

We would like to welcome you to our R2R family!


Reel to Red Productions Student Internship Program was established in August 2004 at The University of Texas Pan-American. It is overseen by the Ofﬁce of University Relations and directed by Radio and Television Production Supervisor Chelse Benham.
Benham created this program to provide students with an opportunity to gain valuable television production skills. R2R has become a home-away-from-home for the interns because of the serious amount of time and commitment they devote to the program, which provides UTPA students with “on-air” reports of University events.

R2R interns produce, edit footage and broadcast the coverage on the closed circuit television system found throughout campus, which keeps the student body informed of what is happening on campus. Most recently, R2R interns took on the task of writing, producing, and directing a motivational ﬁlm for high school students to stay in school and make the right choices about their education. The ﬁlm, titled “Going Nowhere, ” was selected as a ﬁnalist in a national competition and awarded the Telly Award. It also allowed R2R the privilege of being nominated for a Lone Star Emmy Award. R2R also brought home The Communicators Award.

Aside from working on a new project, R2R is also producing the UTPA Today Show, a 30 minute talk show that features students, faculty and staff as well as University events, programs and activities. It is aired on the Edinburg Cable Network Channel 12.
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	Rule-of-Thumb --- 2

	Rule- of-Thumb

These general rules are the most important. As a member of the R2R team you must make sure to follow these rules at all times, or a strike will be marked against you.
Remember three strikes and you are out.

R2R equipment is not to be used for personal purposes.

Punctuality and attendance is extremely important. You are expected to arrive at the time you scheduled yourself to be in the ofﬁce at the beginning of the semester.

Always walk into the ofﬁce well kept; no torn up jeans, holes in the shirts, etc. Act, look and speak professionally.

Do not eat or drink in the ofﬁce.

Clean up your work area of loose papers, stacked up tapes, and debris. Make sure to always sign in and out of the ofﬁce.
You should be in the ofﬁce only when working on a project. Do not use ofﬁce as a hangout.

The ofﬁce is shared with other UR staff; please conduct yourself in a professional and quiet manner. Be respectful toward them and your peers.

Journals are due every Friday via e-mail.

You are responsible following through with all assignments issued to you.
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You are not to invite friends into the ofﬁce, due to the limited space and the sharing with UR staff.

During lunch hour, (12-1) you are not allowed to bring in any friends to the ofﬁce. Keep noise level at a moderate level. (Always wear headphones when working.) Be courteous to others around you.
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	 Assignments


As a member of the R2R team you must make sure to follow these rules at all times, or a strike will be marked against you. Remember three strikes and you are out.


Weekly assignments are scheduled during every Saturday meeting. (It is extremely important that you attend the Saturday Creative meetings.) These assignments are to be ﬁnalized within a timely basis. By the end of the week, all assignments are to be
ready for director’s approval. Also, each event must be accompanied by a DVD yearbook spot.

Journal entries for the week are due via e-mail every Friday. Entries must contain updates of what you have worked on for the week; if you are having any difﬁculties; if interviewed somebody: their contact information, what the interview is/was about; any other information relevant to this internship program. If entries are not
in the director’s e-mail inbox when she checks before Saturday’s creative meeting, you will be turned away, and not allowed to partake in the meeting.
Chelse Benham, director: cfbenham@panam.edu

Promos will be due on the day determined by the director. This is your opportunity to let your creativity run wild. Keep in mind that these promos are being aired on the Edinburg Cable Network Channel 12, and the majority of UTPA administrators are watching them along with our UTPA Today Show. These promos are also being viewed on our closed campus circuit system across campus.

You are responsible to update the director of your progress. It is not the director’s responsibility to track you down to get information.
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“Working as one to capture the essence of life!”
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	   Reporters	


As a member of the R2R team you must make sure to follow these rules at all times, or a strike will be marked against you. Remember three strikes and you are out.


Reporters must behave professionally at all times. Remember you are representing the Ofﬁce of University Relations.

No chewing gum, eating, or drinking on camera.

Hair must be pulled away from face, and no playing with your hair. (Women) No spaghetti straps or bare shoulders.
You must always wear your R2R polo when on camera.  No shirts with insignia.

When interviewing, ask the subject to state their name, spell it out, and give their title or classiﬁcation before an interview.

Turn the microphone towards yourself when speaking and then back to the subject when they are speaking.

Do not make faces, ﬁdget, shake your leg, or any other distractive behavior.

If you won’t be on camera, have the subject respond to your question with a complete thought.
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Do not ﬁll in gaps with: Um, Yeah, etc.

Check ambient noise (noise around you and the subject), to make sure it is not a jarring noise.

If jarring noise occurs, (ambulance, train, leaf blower, etc.) stop, and then start again once it has stopped.

After interview, close with, “This is (YOUR NAME), reporting for Reel to Red.” Hold for 10 seconds, and that’s a wrap.
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	Videographer

As a member of the R2R team you must make sure to follow these rules at all times, or a strike will be marked against you. Remember three strikes and you are out.


Gain speed before starting an interview.

Gain at least 2 minutes of Natural Ambient Sound (NAT) before every shoot. If a major event, make sure to take B-roll, in order to hide or mask getaways. Zoom all the way in to focus, once focus is gained, zoom out to your frame.
White balance when using manual. Always white balance ﬁrst and again when light changes.

Check ambient noise (noise around you and the subject), to make sure it is not a jarring noise.

If jarring noise occurs, (ambulance, train, leaf blower, etc) stop, and then start again once it has stopped.

Always check audio. Always carry headphones. Must use sticks at all times.
Make sure you leave the ofﬁce with all equipment necessary (enough tape, full battery,
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camera light, white sheet of paper to balance, headphones, etc). Always carry the camera bag with you.

Have consistent, focused, steady shots. Movements should be smooth, not sticking. zoom in and out when called for, but do it smoothly.

Do not pan. (Do not use camera to follow eyes.)

When interviewing make sure camera is at eye level with the subject. Always check your camera settings before every shoot.















Always On!
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	 	Editors	


As a member of the R2R team you must make sure to follow these rules at all times, or a strike will be marked against you. Remember three strikes and you are out.


The shooter is responsible for editing, unless other arrangements are made. You have three days to ﬁnish editing the piece and have it ready to lay to tape.
Title all projects when digitizing, never leave project untitled. Save ﬁle to the big hard drive: Mac & Me; Boogaloo; or Lacie. Do not save on Macintosh HD.

Make sure to taper all audio clips (dissolve or fade, no hard cuts). Make sure audio does not peak, or it’s too low.
Do not use wipes (two dimensional).

Cardinal rule: you cannot dissolve between two similar shots. Watch out for illegal colors (blooming, bleeding, etc).
Make sure to place the R2R bug on the left and the title of event and date on the right.

If working on a package for the UTPA Today Show, do not place bug or title. Give names of subjects interviewed and titles to the show editor.

	Reel to Red Productions - Operations Manual
	



 (
Editors
)

Make sure you sign the agreement, and ﬁll out your schedule information.
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I,	, have received and read the Reel to Red Operations Manual. I will abide by these rules given to me. I understand that if any of these rules are violated, I will receive a mark against me and at the end of three marks, I will be reconsidered for this program. I also understand that I must be as professional as possible, for I, along with my
co-workers, represent R2R at all times.










Print Name	Signature



Date	Student ID
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	Date:
	Student ID:

	Name:
	Address:

	Phone:
	

	E-mail:
	

	Birthday:
	

	In the following spaces, put the hours you will be in the ofﬁce on the respective days. Remember you must keep 12 hours per week.
Mentors make sure to work with your protege’s schedule.














Remember this will be your work schedule for the rest of the semester.
You are expected at these hours in the ofﬁce. If any changes occur talk to the director directly.




	
Signature	Date



[image: ]Final Cut Pro: Made Easy
by: Oscar H. Garza


Introduction
Final Cut Pro is a video editing software that is used in major companies to edit and produce films, television programs, and commercials. The software is relatively simple to use; however, there are technical specifications that one should grasp before jumping into the software.
List of Equipment
First, we will begin with a list of equipment that is required. You need an Apple computer to start off with, preferably one that has a G5 processor and has at least 512 megabytes of RAM.
Second, you will need a mini digital video tape deck, or if one is not available, you can use a Firewire connection that plugs directly into the digital camcorder. (Note that using the player on the camcorder will degrade its efficiency.)
[image: ]Third, it is a good idea to have a second hard drive with at least 60 gigabytes of space. If you choose against this and decide to save directly onto the hard drive that has your applications, you will run into a whole mess of problems.
Fourth, you will need at least one Firewire connection, preferably two, one for the deck and the other for the second hard drive. Firewire connections are some of the fastest connections used for file transfer and are essential for this task.
[image: ]
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)Make sure that your capture settings on Final Cut are set to capture in the right place. In order to do that, go to Settings, and click on Capture Settings. There, simply check off where you want your video to be saved.

·  Go to the File menu and click on Save As. Name the project now.
·  Connect the external device (either the camcorder or tape deck) and then go to the View menu, scroll down to the Refresh External Device and click on it.
·  You should now go to the Edit menu and scroll down to the Log and Capture and click on that. A screen will appear that has color bars. If nothing appears, check your connections and repeat step 2.
·  You should now be able to control the external device via the computer. The Log and Capture screen is equipped with play, pause, fast forward and rewind. You should label the footage that you are about to capture in order to avoid confusion.

•6
[image: ]After you name the project in the Capture Settings you are ready to capture the footage. In the lower right hand corner there is a button that reads: capture now. Press it and the computer will automatically begin to transfer the footage. The capturing will occur in real time, so go grab a snack and leave a “Do not disturb” sign.
•7
Once the computer captures the footage that you wanted, it will appear in the upper right hand corner, it will be a purple box icon, and it will be labeled accordingly.
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Fig.
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)8
Now simply drag and drop the footage, which will appear as a purple icon, into the sequence timeline.
9
Now you will see the entire sequence on the timeline. You will be able to scan through the footage easily now by moving the cursor anywhere on the footage bar that will be located in the sequence timeline.

· 10
You will need to become acquianted with the toolbar, it will save you lots of time.
· 
 (
Fig.
 
4
) (
Select
 
tool
)For now the most important tools you will need are the Select Tool and the Cutting Tool. The rest are advanced tools that are not necesarily vital.
· 
 (
Cutting
 
tool
)Look through the footage and cut the pieces of footage that were less than perfect.
· 
Make sure you cut the beginning of the the clip and the end of the clip. Then simply press delete.
· 14
You will now need to locate the transitions/filters. They are in the same place as the complete footage, behind the tab.
· 15
Now that you found it you can simply drag whatever transition you want and place it in between two clips that were not originally next to each other. A cross dissolve will prove to be an effective transition.




· [image: ] (
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)16
Once youʼve made several transitions/filters, you will notice that a reddish line appears over the timeline. This means that Final Cut Pro has made a reference to what you want to do to your footage, and now it needs to actually apply the settings to the footage.
•17
 (
Fig.
 
6
 
red
 
line
)You must now render the selection. To do that, simply go to Sequence in the menu, then go to Render All, and select both.
· [image: ]18
If you waited until the end to do this, it will take some time. It is recommended that you render as often as possible. This will save you some time in the long run and will remind you to save often as well.
· 19
 (
Fig.
 
7
 
Render
)Once you get the hang of this you are ready for your audio transitions. When you cut clips, you not only needed to clean up the look of the footage, but also the sound. The sound bars are located directly below the footage bar.
· 20
You should now search for the clips which youʼve cleaned up with transitions, and make transitions to the audio. It is the same concept as before, and the audio transitions are located right below the video transitions.
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· [image: ]21
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)Now that you are finished with your editing and have rendered all the required areas, you are ready to print to video, but first you must know how to set in and out points. The easiest way of doing this is simply by selecting the timeline, pressing home on your keyboard, then pressing the I key-that will set your in point. Then press the end key and press the O key.
This will set your out point.
· 22
[image: ]Now that youʼve done that, you need to select All Frames. To do this go to View, External Video, then select All Frames.
· 23
Now that youʼve made it this far you will be ready to print to video. To do this go to Edit, Print to Video.
· [image: ]24
When this screen pops up you can now select if you want black, or a slate, or a countdown at the beginning of your finished piece.
· 25
Press OK and it will begin to print to video in real time. You can now enjoy a nice cup of coffee and pat yourself on the back.
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